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GO! with Microsoft Excel 2016 Comprehensive (Gaskin) 

Excel Chapter 1: Creating a Worksheet and Charting Data 

 

1) When using a touchscreen, which of the following actions is the same as clicking an item? 

A) Slide right 

B) Tap the item 

C) Press and hold for a few seconds 

D) Touch the item with two fingers 

Answer:  B 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

2) Using a touchscreen, which of the following actions is the same as right-clicking the mouse? 

A) Slide right 

B) Slide right and then press 

C) Press and hold for a few seconds 

D) Touch the screen with two fingers 

Answer:  C 

Diff: 2 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

3) Which of the following is FALSE about a workbook? 

A) It can contain only one worksheet. 

B) It contains one or more worksheets. 

C) It contains pages called worksheets. 

D) It contains one or more worksheets with a series of cells. 

Answer:  A 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

4) The ________ displays the current cell mode, the page number, and the zoom buttons. 

A) ribbon 

B) status bar 

C) Formula Bar 

D) Quick Access Toolbar 

Answer:  B 

Diff: 2 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

5) In Excel 2016, row heading are identified by ________. 

A) uppercase letters 

B) lowercase letters 

C) roman numerals 

D) numbers 

Answer:  D 

Diff: 2 

Objective:  1. Create, Save, and Navigate an Excel Workbook 
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6) A text value in Excel is also referred to as a ________. 

A) label 

B) formula 

C) constant 

D) cell address 

Answer:  A 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

7) When you type data in a cell and press Enter, what cell becomes the active cell? 

A) The cell to the right 

B) The cell below 

C) The cell above 

D) The insertion point does not move 

Answer:  B 

Diff: 2 

Objective:  2. Enter Data in a Worksheet 

 

8) When you type text in a cell it is ________. 

A) right-aligned 

B) fully justified 

C) left-aligned 

D) centered 

Answer:  C 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

9) Where is the fill handle located? 

A) In the top right of an active cell 

B) In the lower right corner of a selected cell 

C) On the Quick Access Toolbar 

D) On the Home tab 

Answer:  B 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

10) Which of the following is the default number format in Excel 2016? 

A) General format, Calibri, 11 pt 

B) Decimal format, Calibri, 11 pt 

C) General format, Times New Roman, 12 pt 

D) General format, Cambria, 12 pt 

Answer:  A 

Diff: 2 

Objective:  2. Enter Data in a Worksheet 
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11) All formulas begin with a(n) ________. 

A) = sign 

B) % sign 

C) + sign 

D) # sign 

Answer:  A 

Diff: 1 

Objective:  3. Construct and Copy Formulas and Use the SUM Function 

 

12) When a cell is part of an active formula, it is surrounded with ________. 

A) a colored border with small boxes on each side 

B) a colored background with small circles on each corner 

C) a bold, black border with small circles on each side 

D) a white border with small boxes on each corner 

Answer:  A 

Diff: 2 

Objective:  3. Construct and Copy Formulas and Use the SUM Function 

 

13) Which of the following is NOT a way to create a formula? 

A) By typing 

B) By using the point-and-click technique 

C) By using a Function button located on the ribbon 

D) By using a Function button on the status bar 

Answer:  D 

Diff: 2 

Objective:  3. Construct and Copy Formulas and Use the SUM Function 

 

14) ________ is a procedure that determines which digit to the right of a number will be the last 

to be displayed. 

A) Rounding 

B) An absolute cell reference 

C) A constant value 

D) Cell addressing 

Answer:  A 

Diff: 1 

Objective:  3. Construct and Copy Formulas and Use the SUM Function 

 

15) A defined set of formatting characteristics such as font, font size, and font color are known 

as a ________. 

A) label 

B) theme 

C) cell style 

D) series 

Answer:  C 

Diff: 1 

Objective:  4. Format Cells with Merge & Center, Cell Styles, and Themes 
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16) Hold down the ________ key to select nonadjacent cells. 

A) Spacebar 

B) Ctrl 

C) Alt 

D) F2 

Answer:  B 

Diff: 1 

Objective:  4. Format Cells with Merge & Center, Cell Styles, and Themes 

 

17) Which of the following is NOT part of the Accounting Number Format? 

A) A fixed dollar sign aligned at the left edge of the cell 

B) A thousand comma separator 

C) Small amount of space at the right edge of the cell 

D) Three decimal places 

Answer:  D 

Diff: 2 

Objective:  4. Format Cells with Merge & Center, Cell Styles, and Themes 

 

18) Tiny charts embedded in a cell that display a visual trend summary alongside your data are 

called ________. 

A) Sparklines 

B) Data labels 

C) Data series 

D) Data markers 

Answer:  A 

Diff: 2 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

19) What are the two contextual tabs that display under Chart Tools when a chart is selected? 

A) Insert and Format 

B) Format and Design 

C) Insert and Design 

D) Home and Design 

Answer:  B 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

20) Which of the following does not display to the right side of a selected chart? 

A) Chart Styles button 

B) Chart Filters button 

C) Chart Elements button 

D) Move Chart button 

Answer:  D 

Diff: 2 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 
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21) The value axis is also known as the ________. 

A) x-axis 

B) y-axis 

C) category axis 

D) legend 

Answer:  B 

Diff: 2 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

22) A chart value that originates in a worksheet cell is referred to as ________. 

A) a data point 

B) a data marker 

C) a data series 

D) the x-axis 

Answer:  A 

Diff: 2 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

23) To display the document properties, click the ________ tab. 

A) Design 

B) Home 

C) Page Layout 

D) File 

Answer:  D 

Diff: 2 

Objective:  6. Print a Worksheet, Display Formulas, and Close Excel 

 

24) When preparing a document for printing, a ________ indicates that only the columns to the 

left will be printed on the first page. 

A) vertical dotted line between columns 

B) vertical bolded, black line between columns 

C) horizontal bolded line between rows 

D) vertical red, bold line between columns 

Answer:  A 

Diff: 2 

Objective:  6. Print a Worksheet, Display Formulas, and Close Excel 

 

25) The keyboard shortcut to display Print Preview is ________. 

A) Alt + F2 

B) F2 

C) Ctrl + F2 

D) F3 

Answer:  C 

Diff: 2 

Objective:  6. Print a Worksheet, Display Formulas, and Close Excel 
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26) ________ is the keyboard shortcut for the Spelling command. 

A) F1 

B) F2 

C) F7 

D) F12 

Answer:  C 

Diff: 1 

Objective:  7. Check Spelling in a Worksheet 

 

27) The default number format for cells is the ________ number format. 

A) General 

B) Currency 

C) Comma Style 

D) Accounting Number 

Answer:  A 

Diff: 1 

Objective:  8. Enter Data by Range 

 

28) Comma Style format displays a number with ________. 

A) two decimal places 

B) a dollar sign and two decimal places 

C) three decimal places 

D) no decimal places 

Answer:  A 

Diff: 1 

Objective:  9. Construct Formulas for Mathematical Operations 

 

29) Which of the following is NOT one of the default calculations displayed by AutoCalculate? 

A) Sum 

B) Average 

C) Maximum 

D) Count 

Answer:  C 

Diff: 1 

Objective:  9. Construct Formulas for Mathematical Operations 

 

30) The Percent Style button formats selected cells as a percentage with ________. 

A) zero decimal places 

B) one decimal place 

C) two decimal places 

D) three decimal places 

Answer:  A 

Diff: 1 

Objective:  10. Edit Values in a Worksheet 
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31) Normal view maximizes the number of cells visible on your screen. 

Answer:  TRUE 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

32) The Formula Bar in Excel 2016 displays the value or formula in the active cell. 

Answer:  TRUE 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

33) The status bar displays the ribbon as well as the Quick Access Toolbar directly above it. 

Answer:  FALSE 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

34) After column Z in an Excel worksheet, the next column is AA. 

Answer:  TRUE 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

35) An outlined cell in a worksheet is the active cell. 

Answer:  TRUE 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

36) Auto Fill works only with alphabetic values. 

Answer:  FALSE 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

37) Auto Fill generates and extends a series of value into adjacent cells in a worksheet. 

Answer:  TRUE 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

38) The default font for Excel 2016 is Times New Roman 11 pt. 

Answer:  FALSE 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

39) The Quick Analysis tool displays in the lower right corner of a selected range in a worksheet. 

Answer:  TRUE 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 
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40) To indicate a range, include a dash between the two cell references. 

Answer:  FALSE 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

41) The Sum function is so frequently used that it has its own button on the Quick Access 

Toolbar. 

Answer:  FALSE 

Diff: 1 

Objective:  3. Construct and Copy Formulas and Use the SUM Function 

42) Ctrl + = starts the Sum function in a worksheet. 

Answer:  FALSE 

Diff: 1 

Objective:  3. Construct and Copy Formulas and Use the SUM Function 

 

43) The Sum button resides on both the Home tab and the Formulas tab. 

Answer:  TRUE 

Diff: 1 

Objective:  3. Construct and Copy Formulas and Use the SUM Function 

 

44) A relative cell reference is a reference based on the relative position of a cell that contains 

the formula and the cells referred to in the formula. 

Answer:  TRUE 

Diff: 1 

Objective:  3. Construct and Copy Formulas and Use the SUM Function 

 

45) If two cells are merged into one, the cell contents are automatically left justified in the new, 

merged cell. 

Answer:  FALSE 

Diff: 2 

Objective:  4. Format Cells with Merge & Center, Cell Styles, and Themes 

 

46) When two or more cells are merged, the individual cells cannot be selected. 

Answer:  TRUE 

Diff: 1 

Objective:  4. Format Cells with Merge & Center, Cell Styles, and Themes 

 

47) A cell style often includes font, font size, font color, and cell borders. 

Answer:  TRUE 

Diff: 1 

Objective:  4. Format Cells with Merge & Center, Cell Styles, and Themes 

 

48) Sparklines are tiny charts located within a cell that provide a visual trend summary of data. 

Answer:  TRUE 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 
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49) Typically, you should include totals when creating a chart. 

Answer:  FALSE 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

50) You can use the Switch/Row Column command to move a chart from a set of rows on one 

worksheet to a set of columns on another. 

Answer:  FALSE 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

51) The category axis is also known as the y-axis. 

Answer:  FALSE 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

52) A data marker is a value that originates in a worksheet cell. 

Answer:  FALSE 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

53) A data series is a collection of related data points. 

Answer:  TRUE 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

54) Sparklines cannot be formatted. 

Answer:  FALSE 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

55) You can create a custom footer in Excel. 

Answer:  TRUE 

Diff: 1 

Objective:  6. Print a Worksheet, Display Formulas, and Close Excel 

 

56) The Show Formulas button is a toggle button—it is either on or off. 

Answer:  TRUE 

Diff: 1 

Objective:  6. Print a Worksheet, Display Formulas, and Close Excel 

 

57) AutoFit adjusts the width of a column to fit the cell content of the widest cell in the column. 

Answer:  TRUE 

Diff: 1 

Objective:  6. Print a Worksheet, Display Formulas, and Close Excel 
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58) Scaling often works well for printing formulas since it shrinks the width and/or height of a 

printed worksheet. 

Answer:  TRUE 

Diff: 1 

Objective:  6. Print a Worksheet, Display Formulas, and Close Excel 

 

59) Text that is typed in a cell that extends into the next cell only displays if the two cells are 

merged. 

Answer:  FALSE 

Diff: 1 

Objective:  7. Check Spelling in a Worksheet 

 

60) When you type in a cell and the cell to the right contains data, the text in the cell to the left is 

truncated. 

Answer:  TRUE 

Diff: 1 

Objective:  7. Check Spelling in a Worksheet 

 

61) The spelling checker in Excel performs similarly to other Microsoft Office programs. 

Answer:  TRUE 

Diff: 1 

Objective:  7. Check Spelling in a Worksheet 

62) Selecting the range before you enter data saves time because it confines the movement of the 

active cell to the selected range. 

Answer:  TRUE 

Diff: 1 

Objective:  8. Enter Data by Range 

 

63) The asterisk (*) indicates multiplication in Excel 2016. 

Answer:  TRUE 

Diff: 1 

Objective:  9. Construct Formulas for Mathematical Operations 

 

64) The AutoCalculate feature display three calculations by default: Sum, Subtraction, and 

Multiplication. 

Answer:  FALSE 

Diff: 1 

Objective:  9. Construct Formulas for Mathematical Operations 

 

65) The range finder feature in Excel is useful for verifying formulas. 

Answer:  TRUE 

Diff: 1 

Objective:  9. Construct Formulas for Mathematical Operations 
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66) The Percent Style can have fewer or more places after the decimal that the default setting. 

Answer:  TRUE 

Diff: 1 

Objective:  10. Edit Values in a Worksheet 

 

67) The orientation of a worksheet can be changed on the Home tab as well as in Print Preview. 

Answer:  FALSE 

Diff: 1 

Objective:  11. Format a Worksheet 

 

68) The Wrap Text command displays numbers or formulas on multiple lines as well as text. 

Answer:  FALSE 

Diff: 1 

Objective:  11. Format a Worksheet 

 

69) When you delete a column, the remaining columns shift to the left. 

Answer:  TRUE 

Diff: 1 

Objective:  11. Format a Worksheet 

 

70) If you move formulas by inserting additional rows or columns in your worksheet, Excel 

automatically adjusts the formulas.  

Answer:  TRUE 

Diff: 1 

Objective:  11. Format a Worksheet 

 

71) A(n) ________ is an Excel document that stores data. 

Answer:  workbook 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

72) An Excel workbook contains one or more ________ that are stored in the workbook. 

Answer:  worksheets or spreadsheets 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

73) The ________ displays the name given to a selected cell, table, chart, or object. 

Answer:  Name Box 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

74) A(n) ________ is a vertical group of cells in an Excel worksheet. 

Answer:  column 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 
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75) Cell content can be one of two things: a constant value or a(n) ________. 

Answer:  formula 

Diff: 2 

Objective:  2. Enter Data in a Worksheet 

 

76) A cell address is also referred to as a(n) ________. 

Answer:  cell reference 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

77) A(n) ________ is a point of light measured in dots per square inch. 

Answer:  pixel or picture element 

Diff: 2 

Objective:  2. Enter Data in a Worksheet 

 

78) Text or numbers located in a cell in a worksheet are referred to as ________. 

Answer:  data 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

79) A(n) ________ is a prewritten formula that uses one or more cell references, performs an 

operation, and then returns a value. 

Answer:  function 

Diff: 2 

Objective:  3. Construct and Copy Formulas and Use the SUM Function 

 

80) The ________ command joins two or more selected cells together into one cell. 

Answer:  Merge & Center 

Diff: 1 

Objective:  4. Format Cells with Merge & Center, Cell Styles, and Themes 

 

81) A(n) ________ is a predefined set of colors, fonts, line, and fill effects that coordinate for an 

attractive look. 

Answer:  theme 

Diff: 2 

Objective:  4. Format Cells with Merge & Center, Cell Styles, and Themes 

82) A(n) ________ is a graphic representation of data in a worksheet. 

Answer:  chart 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

83) The ________ command moves charted data from the vertical axis to the horizontal axis or 

vice versa. 

Answer:  Switch/Row Column 

Diff: 2 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 
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84) A(n) ________ is a chart element that identifies the patterns or colors that are assigned to 

each category in the chart. 

Answer:  legend 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

85) The ________ gallery displays a set of predefined characteristics that change the overall 

visual look of a chart. 

Answer:  Chart Styles 

Diff: 1 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

 

86) The shortcut key for accessing the Spelling command is ________. 

Answer:  F7 

Diff: 1 

Objective:  7. Check Spelling in a Worksheet 

 

87) When you select a range of data, the ________ button displays. 

Answer:  Quick Analysis 

Diff: 2 

Objective:  8. Enter Data by Range 

 

88) A(n) ________ is a symbol with which you can specify the type of calculation that you want 

in a formula. 

Answer:  operator 

Diff: 2 

Objective:  9. Construct Formulas for Mathematical Operations 

 

89) A(n) ________ refers to a cell with a fixed position in the worksheet. 

Answer:  absolute cell reference 

Diff: 2 

Objective:  9. Construct Formulas for Mathematical Operations 

 

90) ________ is the term for specifying the appearance of cells and overall layout of a 

worksheet. 

Answer:  Formatting  

Diff: 1 

Objective:  11. Format a Worksheet 
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91) Match each of the following terms to its definition: 

I. cell 

II. worksheet 

III. spreadsheet 

IV. workbook 

V. column 

 

A. displays upon startup of Excel 

B. group of vertical cells on a worksheet 

C. also known as a spreadsheet 

D. intersection of a row and column 

E. also known as a worksheet 

Answer:  D, C, E, A, B 

Diff: 1 

Objective:  1. Create, Save, and Navigate an Excel Workbook 

 

92) Match each of the following actions with the tab on which it is activated: 

I. display formulas on the screen 

II. exporting a document as a PDF file 

III. create a recommended chart 

IV. AutoFit column widths 

V. change a worksheet to landscape orientation 

 

A. Formulas tab 

B. Page Layout tab 

C. Insert tab 

D. File tab 

E. Home tab 

Answer:  A, D, C, E, B 

Diff: 1 

Objective:  Multiple Objectives 

 



15 
Copyright © 2017 Pearson Education, Inc. 

93) Match each of the following terms to its definition: 

I. row 

II. column 

III. formula 

IV. label 

V. value 

 

A. an equation that performs mathematical calculations 

B. a text value 

C. group of vertical cells on a worksheet 

D. group of horizontal cells on a worksheet 

E. a number, date, or time of day 

Answer:  D, C, A, B, E 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

94) Match each of the keyboard shortcuts to its action: 

I. Shift + Tab 

II. Shift + Enter 

III. PageDown 

IV. Ctrl + End 

V. Tab 

 

A. moves left one cell 

B. moves right one cell 

C. moves down one full screen  

D. moves one cell up 

E. moves to the last cell in the last column of the active area of a worksheet 

Answer:  A, D, C, E, B 

Diff: 1 

Objective:  2. Enter Data in a Worksheet 

 

95) Match each of the following terms to its definition: 

I. cell style 

II. theme 

III. format 

IV. Accounting Number Format 

V. Comma Style 

 

A. a thousand comma separator, dollar sign, and two decimal places 

B. a thousand comma separator, two decimal places, and space at the right of the cell 

C. defined set of formatting characteristics 

D. change the appearance of cell contents 

E. predefined set of features that coordinate for an attractive look 

Answer:  C, E, D, A, B 

Diff: 1 

Objective:  4. Format Cells with Merge & Center, Cell Styles, and Themes 
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96) Match each of the following terms to its definition: 

I. data series 

II. data point 

III. data marker 

IV. y-axis 

V. x-axis 

 

A. a symbol in a chart that represents a single data point 

B. related data points 

C. also known as the category axis 

D. also known as the value axis 

E. a value that originates in a cell 

Answer:  B, E, A, D, C 

Diff: 2 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 

97) Match each of the following terms to its definition: 

I. operator 

II. pixel 

III. number values 

IV. underlying value 

V. data 

 

A. symbol used to specify the type of calculation that you want in a formula 

B. text or numbers in a cell 

C. a dot of light on a screen 

D. constant values consisting only of numbers 

E. data that displays in the Formula bar 

Answer:  A, C, D, E, B 

Diff: 2 

Objective:  5. Chart Data to Create a Column Chart and Insert Sparklines 
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